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Chapter 1. Overview of IBM Sterling Business Intelligence

IBM® Sterling Business Intelligence is an analytical solution that can be used by
users of this application to aggregate the data that is available across supply chain
products of IBM and generate performance reports relevant to their business.

This document contains instructions for installing the various components of the
Sterling Business Intelligence application. It also describes the components of the
Sterling Business Intelligence application, and provides information about how to
set these up in a typical implementation.

Intended Audience
This document provides installation and administration information for individuals
who are responsible for installing and maintaining the Sterling Business
Intelligence application.

This document assumes that the users of Sterling Business Intelligence have
working knowledge about installing the IBM Cognos® Business Intelligence suite of
products as well as the IBM Sterling Selling and Fulfillment Foundation. Therefore,
it is recommended that you read the related IBM Cognos documentation before
attempting to install the Sterling Business Intelligence application.

Conventions
The following conventions may be used in this manual:

Convention
Meaning

<AC_INSTALL_DIR>

User-supplied location where IBM Sterling Business Intelligence Content is
installed. This directory exists on the server where IBM Cognos Adaptive
Warehouse is installed.

<INSTALL_DIR>

User-supplied location of the Sterling Selling and Fulfillment Foundation,
Release 9.2 installation directory.

<BI_COGNOS_HOME>

User-supplied location of the IBM Sterling Business Intelligence Content is
installed. This directory exists on the server where IBM Cognos Business
Intelligence is installed.

<c_installation>

User-supplied location of the Cognos Business Intelligence installation
directory.

<c_path>
Location of the Cognos Business Intelligence installation directory. For
example, <c_path> will contain the value c10 for 32 bit installation and
c10_64 for 64 bit installation.

© Copyright IBM Corp. 2009, 2011 1



<IM_INSTALL_DIR>
Location where the IBM Installation Manager is installed.
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Chapter 2. Planning the Installation

Installing Sterling Business Intelligence is broken up into distinct stages. You begin
with planning the installation and environment to install Sterling Business
Intelligence application, Cognos Business Intelligence server and Cognos Analytic
Applications. At this point, you install the software. After installing, you must
perform deployment tasks for the components you have installed.

The following workflow outlines the tasks you must complete for each of these
components.

Table 1. Installation Workflow

Task Information Description

Review the Sterling
Business
Intelligence
ecosystem.

Chapter 3, “Understanding the
IBM Sterling Business Intelligence
Ecosystem,” on page 5

Understand the different
components that have to be
installed for Sterling Business
Intelligence. Also, review the
system requirements.

Install Sterling
Business
Intelligence
application

Chapter 4, “Installing the IBM
Sterling Business Intelligence
Application,” on page 9

Complete all the prerequisites
that are required before you
install Sterling Business
Intelligence application.

Install Cognos
Business
Intelligence server

Chapter 6, “Installing IBM Cognos
Business Intelligence Server,” on
page 27

Install Cognos
Adaptive Analytics

Chapter 9, “Installing the IBM
Cognos Adaptive Analytics,” on
page 33

Install Cognos
Adaptive
Warehouse

Chapter 7, “Installing the IBM
Cognos Adaptive Warehouse,” on
page 29

Install Cognos
Adaptive
Warehouse
Runtime

Chapter 8, “Installing the IBM
Cognos Adaptive Warehouse
Runtime,” on page 31

Install IBM Sterling
Business
Intelligence
Content

Chapter 10, “Installing the IBM
Sterling Business Intelligence
Content,” on page 35

Deploy Sterling
Business
Intelligence

Chapter 11, “Deploy IBM Sterling
Business Intelligence,” on page 41

Administer
Security

“Set Up the IBM Sterling Business
Intelligence Authentication
Mechanism” on page 51

Verify Sterling
Business
Intelligence
Installation

Chapter 13, “Verify the IBM
Sterling Business Intelligence
Installation,” on page 57

Chapter 14, “Verify the IBM
Sterling Business Intelligence
Report,” on page 59
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Chapter 3. Understanding the IBM Sterling Business
Intelligence Ecosystem

The best option of installing the Sterling Business Intelligence components depends
on your individual requirements, resources, and preferences. It is recommended
that you install each of the Sterling Business Intelligence components on different
servers as described in the following diagram:

IBM Sterling Business Intelligence Application
The Sterling Business Intelligence application is installed on Sterling Selling and
Fulfillment Foundation. The Sterling Business Intelligence application is installed
on server 1. The application consists of a Web User Interface (UI) and related APIs'
that help you select the reports criteria and generate reports. The application also
installs framework components related to efficient change data capture, and other
configuration data essential for the application to work.

© Copyright IBM Corp. 2009, 2011 5



Sterling Source Database
The Sterling Source Database hosts the online transaction processing (OLTP)
database server, which is installed on server 2. This is used as a source data server.
The technical stack requirements for this system are the same as that required for a
database server in Sterling Selling and Fulfillment Foundation.

Sterling Staging Database
The Sterling Staging Database is the source for the data mart, and is installed on
server 3. The staging environment consists of a database in which the incremental
transaction data that is extracted, transformed, and loaded (ETL) from the source is
stored.

Sterling Data Mart Database
The Sterling Data Mart Database is the environment in which the data mart is
hosted. This is installed on server 8. The data in this database is dimensionally
modeled data that is analytics-friendly.

IBM Cognos Business Intelligence Server
The Sterling Business Intelligence uses the report generation capability of Cognos
Business Intelligence to create and manage ad hoc reports and scheduled reports. It
is installed on server 4. It includes IBM Cognos Query Studio and IBM Cognos
Report Studio. Cognos Query Studio is a Web-based tool that enables you to create
ad hoc reports by selecting items from a package file. Cognos Report Studio is a
Web-based tool used to build sophisticated, multiple-page, multiple-query reports.

IBM Cognos Analytic Applications
The Cognos Analytic Applications includes the following components:
v Cognos Adaptive Warehouse

Cognos Adaptive Warehouse is a data modeling environment used to design
and populate a target data warehouse. It provides an interface that facilitates the
extraction, transformation, and loading of application-specific data from the
source database into the target data warehouse. It helps you construct a source
model that describes the rules for querying the source database. This component
is installed on server 5.

v Cognos Adaptive Warehouse Runtime

This component is used by the Cognos Adaptive Warehouse user interface and
scripts. The Cognos Adaptive Warehouse Runtime helps to run the extract,
transform, and load (ETL) scripts in different environments.
If you install Cognos Adaptive Warehouse on Microsoft Windows, then you can
install Cognos Adaptive Warehouse Runtime on the same server 5. Optionally,
you can install Cognos Adaptive Warehouse Runtime on a Windows computer
server 6, that is separate from Cognos Adaptive Warehouse.

v IBM Cognos Adaptive Analytics

This is an information modeling tool for generating and deploying analytic
reports and operational reports to the Sterling Business Intelligence portal. After
publishing the data model in Cognos Adaptive Warehouse, you can use Cognos
Adaptive Analytics to create and publish analytic reports. This component is
installed on server 4, along with Cognos Business Intelligence.
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IBM Sterling Business Intelligence Content
The IBM Sterling Business Intelligence Content consists of analytics content files
for your system. The IBM Sterling Business Intelligence Content contains the
following data:
v Dashboard reports and files required for communication between the Cognos

Business Intelligence server and Sterling Business Intelligence .
v Metadata files that serve as the data mart model as well as the report

specification.

System Requirements
For more information about system requirements, go to the IBM Support Portal at
http://www-947.ibm.com/support/entry/portal/Planning.

Chapter 3. Understanding the IBM Sterling Business Intelligence Ecosystem 7
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Chapter 4. Installing the IBM Sterling Business Intelligence
Application

The Sterling Business Intelligence application should be installed on server 1, as
described in the topic Chapter 3, “Understanding the IBM Sterling Business
Intelligence Ecosystem,” on page 5.

Note: You will be directed to perform either a single schema installation or a
multi-schema installation based on the configuration of Sterling Selling and
Fulfillment Foundation, Release 9.2.

Ensure that there is at least 1 GB of free disk space is available for installation.

Installing IBM Sterling Business Intelligence Application using IBM
Installation Manager GUI for Single Schema on Windows

Before you begin

Running the IBM Installation Manager in both GUI mode and command line mode
is not supported. Therefore, if the command line mode of the IBM Installation
Manager is open, ensure that you close it.

Ensure that you have performed the following tasks before you proceed with your
Sterling Business Intelligence installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you have installed Sterling Selling and Fulfillment Foundation,
Release 9.2 in single schema mode on Windows. For more information about
installing Sterling Selling and Fulfillment Foundation, refer to the Sterling
Selling and Fulfillment Foundation: Installation Guide.

3. Ensure that the database schema is created and configured for both the staging
and the data mart. For more information about configuration settings for the
data warehouse database, refer to the following link :http://
publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db.

About this task

You will find instructions to install Sterling Business Intelligence using the IBM
Installation Manager GUI on Windows.

Procedure
1. Execute the following command to start the IBM Installation Manager :

<IM_INSTALL_DIR>\eclipse\launcher.exe The Start page of the Installation
Manager is displayed.

2. Add the Sterling Business Intelligence application installer repository location
in the IBM Installation Manager as follows:

© Copyright IBM Corp. 2009, 2011 9
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a. In Installation Manager, click File > Preferences... > Repositories. The
Preferences page opens and displays the available repositories, repository
locations, and the connection status for the repositories.

b. Click Add Repository.

c. Enter the repository location or click Browse. When browsing, navigate to
the repository location and select the repository.config, file for the
installer.

d. Click OK. The new repository location is added to the list. If the repository
is not connected, a red box is displayed in the Connection column. Debug
your connectivity issues.

e. Click OK to close the Preferences page.
3. Click Install in the IBM Installation Manager home page.
4. Select the IBM Sterling Business Intelligence check box. Click Next.
5. Click Use the existing package group. Click Next.
6. In the Features page, ensure that IBM Sterling Business Intelligence check box

is selected. Click Next.
7. The Datamart Database Information page is displayed, with the database

vendor name. In the Datamart Database Information page, enter the
information for the fields described in the table below. The supported
databases are Oracle and DB2. Ensure that the schema is created with the
UTF-8 character set enabled. For more details about enabling the UTF-8
character set, refer to the documentation related to the database vendor.

Field Description

Database user name

Name of the database user.

Database password

Password of the database user to access the database.

Confirm database password

Re-enter the password.

Database catalog name

Name of the database catalog. If the database is DB2, enter the DB2
catalog name and if it is Oracle, enter SID.

Database schema name

Name of the database schema.

Database host name

IP address or host name of the location in which the database is
installed.

Database port

Port number of the database.

JDBC driver file
Click Add Jars to browse to the JDBC driver file for Oracle or DB2.
Repeat to add the license file for DB2 (required).

To test the connection to the database, click Validate Connection. If a
message saying the connection failed is displayed, verify the
information entered in all fields and click Validate Connection.
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8. Click Next.
9. In the Staging Database Information page, enter the information related to

the database as described in the table below. The supported databases are
Oracle and DB2.
Ensure that the schema is created with the UTF-8 character set enabled. For
more details about enabling the UTF-8 character set, refer to the
documentation related to the database vendor.

Field Description

Database user name

Name of the database user.

Database password

Password of the database user to access the database.

Confirm database password

Re-enter the password.

Database catalog name

Name of the database catalog. If the database is DB2, enter the DB2
catalog name and if it is Oracle, enter SID.

Database schema name

Name of the database schema.

Database host name

IP address or host name of the location in which the database is
installed.

Database port

Port number of the database.

JDBC driver file
Click Add Jars to browse to the JDBC driver file for Oracle or DB2.
Repeat to add the license file for DB2 (required).

To test the connection to the database, click Validate Connection. If a
message saying the connection failed is displayed, verify the
information entered in all fields and click Validate Connection.

10. Click Next.
11. In the Summary page, the Packages are displayed. Click Install. A progress

indicator displays the percentage of the installation completed.
12. On successful completion, the Install Packages window is displayed with the

package details.
13. (Optional) Click View log file to open the installation log file for the current

session in a new window. You must close the Installation Log window to
continue.

Note: If the installation was not successful, click on the View log file to view
the failure reason.

14. Click Finish to complete the installation.
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Installing IBM Sterling Business Intelligence Application using IBM
Installation Manager Command Line for Single Schema on Windows

Before you begin

You cannot run the IBM Installation Manager in both GUI and command line
mode. Hence, ensure that you have closed the GUI of the IBM Installation
Manager.

Ensure that you have performed the following tasks before you proceed with your
Application installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you have installed Sterling Selling and Fulfillment Foundation, 9.2
in Windows environment. For more information about installing Sterling Selling
and Fulfillment Foundation, refer to the Sterling Selling and Fulfillment
Foundation: Installation Guide.

3. Ensure that the database schema is created and configured for both the staging
and the data mart. For more information about configuration settings for the
data warehouse database, refer to the following link:http://
publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db

About this task

You can also install the Sterling Business Intelligence using the IBM Installation
Manager command line (imcl) installation command. The imcl command provides
a text-based (non-GUI) interface.

Procedure
1. Execute the imcl command as follows:

v <IM_INSTALL_DIR>\eclipse\tools\imcl -consoleMode

Here,

<IM_INSTALL_DIR>
Indicates the directory where the IBM Installation Manager is installed.

2. Add the Sterling Business Intelligence installer repository location in the IBM
Installation Manager as follows:
a. Type P to select Preferences and press Enter.
b. Type 1 to select Repositories and press Enter.
c. Type D to select Add Repository and press Enter.
d. Enter the repository location to point to the repository.config file and

press Enter. A message will be displayed with the connection status of the
repository.

e. Type A to apply the changes and return to Preferences and press Enter.
f. Type R to return to the main menu and press Enter.

3. Install the Sterling Business Intelligence as follows:
a. Type 1 to install and press Enter.
b. Type the number associated with the IBM Sterling Business Intelligence

package and press Enter.
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c. Type 1 to choose version 9.2.0 and press Enter.
d. Type N and press Enter.
e. Type M to change the location where Sterling Selling and Fulfillment

Foundation is installed, using the IBM Installation Manager.
f. Enter the location where Sterling Selling and Fulfillment Foundation is

installed and press Enter.
g. Type N and press Enter.
h. Type N and press Enter.
i. The data mart vendor information is displayed. Enter the Database user

Name for the data mart and press Enter.
j. Enter the user password for the data mart and press Enter.
k. Enter the Database catalog Name for the data mart and press Enter. If the

database is DB2, enter the DB2 catalog name and if it is Oracle, enter SID.
l. Enter the Database Schema Name for the data mart and press Enter.
m. Enter the Database host Name for the data mart and press Enter.
n. Enter the Database port Number for the data mart and press Enter.
o. Enter the Database driver jars for the data mart and press Enter. The

supported databases are Oracle and DB2. Enter the location of the JDBC
driver file for Oracle or DB2. Repeat to add the license file for DB2
(required).

p. Type A to Add jar.
q. Type D when you have finished adding the jar.
r. The staging vendor information is displayed. Enter the Database user Name

for the staging and press Enter.
s. Enter the Database password for the staging and press Enter.
t. Enter the Database catalog Name for the staging and press Enter.
u. Enter the Database Schema Name for the staging and press Enter.
v. Enter the Database host Name for the staging and press Enter.
w. Enter the Database port Number for the staging and press Enter.
x. Enter the Database driver jars for the staging and press Enter. The

supported databases are Oracle and DB2.
y. Type A to Add jar. Enter the location of the JDBC driver file for Oracle or

DB2. Repeat to add the license file for DB2 (required).
z. Type D when you have finished adding the jar.
aa. Type Y to validate the connection to the database.
ab. If the database validation is successful. Type I to install and press Enter. A

progress indicator shows the percentage of installation completed.
ac. After the installation is complete, the installation status is displayed.

Installing IBM Sterling Business Intelligence Application using IBM
Installation Manager GUI for Single Schema on Unix or Linux

Before you begin

Running the IBM Installation Manager in both GUI mode and command line mode
is not supported. Therefore, if the command line mode of the IBM Installation
Manager is open, ensure that you close it.
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Ensure that you have performed the following tasks before you proceed with your
installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you have installed Sterling Selling and Fulfillment Foundation,
Release 9.2 in single schema mode on Windows. For more information about
installing Sterling Selling and Fulfillment Foundation, refer to the Sterling
Selling and Fulfillment Foundation: Installation Guide.

3. Ensure that the database schema is created and configured for both the staging
and the data mart. For more information about configuration settings for the
data warehouse database, refer to the following link:http://
publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db.

4. Ensure that you set the display to your remote server using the following
command:
export DISPLAY=<server_ip_address>:0.0

For example, export DISPLAY=10.11.12.1:0.0

About this task

You will find instructions to install Sterling Business Intelligence using the IBM
Installation Manager GUI on Unix or Linux.

Procedure
1. Execute the following command to start the IBM Installation Manager :

<IM_INSTALL_DIR>/eclipse/launcher The Start page of the Installation
Manager is displayed.

2. Add the Sterling Business Intelligence application installer repository location
in the IBM Installation Manager as follows:
a. In Installation Manager, click File > Preferences... > Repositories. The

Preferences page opens and displays the available repositories, repository
locations, and the connection status for the repositories.

b. Click Add Repository.

c. Enter the repository location or click Browse. When browsing, navigate to
the repository location and select the repository.config, file for the
installer.

d. Click OK. The new repository location is added to the list. If the repository
is not connected, a red box is displayed in the Connection column. Debug
your connectivity issues.

e. Click OK to close the Preferences page.
3. Click Install in the IBM Installation Manager home page.
4. Select the IBM Sterling Business Intelligence check box. Click Next.
5. Click Use the existing package group. Click Next.
6. In the Features page, ensure that IBM Sterling Business Intelligence check box

is selected. Click Next.
7. The Datamart Database Information page is displayed, with the database

vendor name. In the Datamart Database Information page, enter the
information for the fields described in the table below. The supported
databases are Oracle and DB2.
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Ensure that the schema is created with the UTF-8 character set enabled. For
more details about enabling the UTF-8 character set, refer to the
documentation related to the database vendor.

Field Description

Database user name

Name of the database user.

Database password

Password of the database user to access the database.

Confirm database password

Re-enter the password.

Database catalog name

Name of the database catalog. If the database is DB2, enter the DB2
catalog name and if it is Oracle, enter SID .

Database schema name

Name of the database schema.

Database host name

IP address or host name of the location in which the database is
installed.

Database port

Port number of the database.

JDBC driver file
Click Add Jars to browse to the JDBC driver file for Oracle or DB2.
Repeat to add the license file for DB2 (required).

To test the connection to the database, click Validate Connection. If a
message saying the connection failed is displayed, verify the
information entered in all fields and click Validate Connection.

8. Click Next.
9. In the Staging Database Information page, enter the information related to

the database as described in the table below. The supported databases are
Oracle and DB2.
Ensure that the schema is created with the UTF-8 character set enabled. For
more details about enabling the UTF-8 character set, refer to the
documentation related to the database vendor.

Field Description

Database user name

Name of the database user.

Database password

Password of the database user to access the database.

Confirm database password

Re-enter the password.

Database catalog name
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Name of the database catalog. If the database is DB2, enter the DB2
catalog name and if it is Oracle, enter SID.

Database schema name

Name of the database schema.

Database host name

IP address or host name of the location in which the database is
installed.

Database port

Port number of the database.

JDBC driver file
Click Add Jars to browse to the JDBC driver file for Oracle or DB2.
Repeat to add the license file for DB2 (required).

To test the connection to the database, click Validate Connection. If a
message saying the connection failed is displayed, verify the
information entered in all fields and click Validate Connection.

10. Click Next.
11. In the Summary page, the Packages are displayed. Click Install. A progress

indicator displays the percentage of the installation completed.
12. On successful completion, the Install Packages window is displayed with the

package details.
13. (Optional) Click View log file to open the installation log file for the current

session in a new window. You must close the Installation Log window to
continue.

Note: If the installation was not successful, click on the View log file to view
the failure reason in the log file.

14. Click Finish to complete the installation.

Installing IBM Sterling Business Intelligence Application using IBM
Installation Manager Command Line for Single Schema on Unix or
Linux

Before you begin

You cannot run the IBM Installation Manager in both GUI and command line
mode. Hence, ensure that you have closed the GUI of the IBM Installation
Manager.

Ensure that you have performed the following tasks before you proceed with your
Application installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you have installed Sterling Selling and Fulfillment Foundation, 9.2
in Unix or Linux environment. For more information about installing Sterling
Selling and Fulfillment Foundation, refer to the Sterling Selling and Fulfillment
Foundation: Installation Guide.

3. Ensure that the database schema is created and configured for both the staging
and the data mart. For more information about configuration settings for the
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data warehouse database, refer to the following link:http://
publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db

About this task

You can also install the Sterling Business Intelligence using the IBM Installation
Manager command line (imcl) installation command. The imcl command provides
a text-based (non-GUI) interface.

Procedure
1. Execute the imcl command as follows:

v <IM_INSTALL_DIR>/eclipse/tools/imcl -consoleMode

Here,

<IM_INSTALL_DIR>
Indicates the directory where the IBM Installation Manager is installed.

2. Add the Sterling Business Intelligence installer repository location in the IBM
Installation Manager as follows:
a. Type P to select Preferences and press Enter.
b. Type 1 to select Repositories and press Enter.
c. Type D to select Add Repository and press Enter.
d. Enter the repository location to point to the repository.config file and

press Enter. A message will be displayed with the connection status of the
repository.

e. Type A to apply the changes and return to Preferences and press Enter.
f. Type R to return to the main menu and press Enter.

3. Install the Sterling Business Intelligence as follows:
a. Type 1 to install and press Enter.
b. Type the number associated with the IBM Sterling Business Intelligence

package and press Enter.
c. Type 1 to choose version 9.2.0 and press Enter.
d. Type N and press Enter.
e. Type M to change the location where Sterling Selling and Fulfillment

Foundation is installed, using the IBM Installation Manager.
f. Enter the location where Sterling Selling and Fulfillment Foundation is

installed and press Enter.
g. Type N and press Enter.
h. Type N and press Enter.
i. The data mart vendor information is displayed. Enter the Database user

Name for the data mart and press Enter.
j. Enter the Database password for the data mart and press Enter.
k. Enter the Database catalog Name for the data mart and press Enter. If the

database is DB2, enter the DB2 catalog name and if it is Oracle, enter SID.
l. Enter the Database Schema Name for the data mart and press Enter.
m. Enter the Database host Name for the data mart and press Enter.
n. Enter the Database port Number for the data mart and press Enter.
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o. Enter the Database driver jars for the data mart and press Enter. The
supported databases are Oracle and DB2. Enter the location of the JDBC
driver file for Oracle or DB2. Repeat to add the license file for DB2
(required).

p. Type A to Add jar.
q. Type D when you have finished adding the jar.
r. The staging vendor information is displayed. Enter the Database user Name

for the staging and press Enter.
s. Enter the user password for the staging and press Enter.
t. Enter the Database catalog Name for the staging and press Enter. If the

database is DB2, enter the DB2 catalog name and if it is Oracle, enter SID.
u. Enter the Database Schema Name for the staging and press Enter.
v. Enter the Database host Name for the staging and press Enter.
w. Enter the Database port Number for the staging and press Enter.
x. Enter the Database driver jars for the staging and press Enter. The

supported databases are Oracle and DB2. Enter the location of the JDBC
driver file for Oracle or DB2. Repeat to add the license file for DB2
(required).

y. Type A to Add jar.
z. Type D when you have finished adding the jar.
aa. Type Y to validate the connection to the database.
ab. Type I to install and press Enter. A progress indicator shows the

percentage of installation completed.
ac. After the installation is complete, the installation status is displayed.

Installing IBM Sterling Business Intelligence using IBM Installation
Manager GUI for Multi Schema on Windows

Before you begin

Running the IBM Installation Manager in both GUI mode and command line mode
is not supported. Therefore, if the command line mode of the IBM Installation
Manager is open, ensure that you close it.

Ensure that you have performed the following tasks before you proceed with your
Sterling Business Intelligence installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you have installed Sterling Selling and Fulfillment Foundation,
Release 9.2 in multi schema mode on Windows. For more information about
installing Sterling Selling and Fulfillment Foundation, refer to the Sterling
Selling and Fulfillment Foundation: Installation Guide.

3. Ensure that the database schema is created and configured for both the staging
and the data mart. For more information about configuration settings for the
data warehouse database, refer to the following link:http://
publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db
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About this task

You will find instructions to install Sterling Business Intelligence using the IBM
Installation Manager GUI on Windows.

Procedure
1. Start the IBM Installation Manager. The Start page of the Installation Manager

is displayed.
2. Add the Sterling Business Intelligence installer repository location in the IBM

Installation Manager as follows:
a. In Installation Manager, click File > Preferences... > Repositories. The

Repositories page opens and displays the available repositories, repository
locations, and the connection status for the repositories.

b. Click Add Repository.

c. Enter the repository location or click Browse. When browsing, navigate to
the repository location and select the repository.config, file for the
installer.

d. Click OK. The new repository location is added to the list. If the repository
is not connected, a red box is displayed in the Connection column.

e. Click OK to close the Preference page.
3. Click Install .
4. Select the IBM Sterling Business Intelligence. Click Next.
5. Click Use the existing package group. Click Next.
6. In the Features page, ensure that IBM Sterling Business Intelligence check box

is selected. Click Next.
7. In the Summary page, the Packages are displayed. Click Install. A progress

indicator displays the percentage of the installation completed.
8. (Optional) Click View log file to open the installation log file for the current

session in a new window. You must close the Installation Log window to
continue.

9. Click Finish to complete the installation.

Installing IBM Sterling Business Intelligence using IBM Installation
Manager Command Line for Multi Schema on Windows

Before you begin

You cannot run the IBM Installation Manager in both GUI and command line
mode. Hence, ensure that you have closed the GUI of the IBM Installation
Manager.

Ensure that you have performed the following tasks before you proceed with your
Application installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you have installed Sterling Selling and Fulfillment Foundation, 9.2
in Windows environment. For more information about installing Sterling Selling
and Fulfillment Foundation, refer to the Sterling Selling and Fulfillment
Foundation: Installation Guide.
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3. Ensure that the database schema is created and configured for both the staging
and the data mart. For more information about configuration settings for the
data warehouse database, refer to the following link:http://
publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db

About this task

You can also install the Sterling Business Intelligence using the IBM Installation
Manager command line (imcl) installation command. The imcl command provides
a text-based (non-GUI) interface.

Procedure
1. Execute the imcl command as follows:

v <IM_INSTALL_DIR>\eclipse\tools\imcl -consoleMode

Here,

<IM_INSTALL_DIR>
Indicates the directory where the IBM Installation Manager is installed.

2. Add the Sterling Business Intelligence installer repository location in the IBM
Installation Manager as follows:
a. Type P to select Preferences and press Enter.
b. Type 1 to select Repositories and press Enter.
c. Type D to select Add Repository and press Enter.
d. Enter the repository location to point to the repository.config file and

press Enter. A message will be displayed with the connection status of the
repository.

e. Type A to apply the changes and return to Preferences and press Enter.
f. Type R to return to the main menu and press Enter.

3. Install the Sterling Business Intelligence as follows:
a. Type 1 to install and press Enter.
b. Type the number associated with the IBM Sterling Business Intelligence

package and press Enter.
c. Type 1 to choose version 9.2.0 and press Enter.
d. Type N and press Enter.
e. Type M to change the location where Sterling Selling and Fulfillment

Foundation is installed, using the IBM Installation Manager.
f. Enter the location where Sterling Selling and Fulfillment Foundation is

installed and press Enter.
g. Type N and press Enter.
h. Type I to install and press Enter. A progress indicator shows the percentage

of installation completed.
i. After the installation is complete, the installation status is displayed.
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Installing IBM Sterling Business Intelligence using IBM Installation
Manager GUI for Multi Schema on Unix or Linux

Before you begin

Running the IBM Installation Manager in both GUI mode and command line mode
is not supported. Therefore, if the command line mode of the IBM Installation
Manager is open, ensure that you close it.

Ensure that you have performed the following tasks before you proceed with your
Sterling Business Intelligence installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you have installed Sterling Selling and Fulfillment Foundation,
Release 9.2 in multi schema mode on Unix or Linux. For more information
about installing Sterling Selling and Fulfillment Foundation, refer to the Sterling
Selling and Fulfillment Foundation: Installation Guide.

3. Ensure that the database schema is created and configured for both the staging
and the data mart. For more information about configuration settings for the
data warehouse database, refer to the following link:http://
publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db

About this task

You will find instructions to install Sterling Business Intelligence using the IBM
Installation Manager GUI on Unix or Linux.

Procedure
1. Start the IBM Installation Manager. The Start page of the Installation Manager

is displayed.
2. Add the Sterling Business Intelligence installer repository location in the IBM

Installation Manager as follows:
a. In Installation Manager, click File > Preferences... > Repositories. The

Repositories page opens and displays the available repositories, repository
locations, and the connection status for the repositories.

b. Click Add Repository.

c. Enter the repository location or click Browse. When browsing, navigate to
the repository location and select the repository.config, file for the
installer.

d. Click OK. The new repository location is added to the list. If the repository
is not connected, a red box is displayed in the Connection column.

e. Click OK to close the Preference page.
3. Click Install .
4. Select the IBM Sterling Business Intelligence. Click Next.
5. Click Use the existing package group. Click Next.
6. In the Features page, ensure that IBM Sterling Business Intelligence check box

is selected. Click Next.
7. In the Summary page, the Packages are displayed. Click Install. A progress

indicator displays the percentage of the installation completed.
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8. (Optional) Click View log file to open the installation log file for the current
session in a new window. You must close the Installation Log window to
continue.

9. Click Finish to complete the installation.

Installing IBM Sterling Business Intelligence using IBM Installation
Manager Command Line for Multi Schema on Unix or Linux

Before you begin

You cannot run the IBM Installation Manager in both GUI and command line
mode. Hence, ensure that you have closed the GUI of the IBM Installation
Manager.

Ensure that you have performed the following tasks before you proceed with your
Application installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you have installed Sterling Selling and Fulfillment Foundation, 9.2
in Unix or Linux environment. For more information about installing Sterling
Selling and Fulfillment Foundation, refer to the Sterling Selling and Fulfillment
Foundation: Installation Guide.

3. Ensure that the database schema is created and configured for both the staging
and the data mart. For more information about configuration settings for the
data warehouse database, refer to the following link:http://
publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db

About this task

You can also install the Sterling Business Intelligence using the IBM Installation
Manager command line (imcl) installation command. The imcl command provides
a text-based (non-GUI) interface.

Procedure
1. Execute the imcl command as follows:

v <IM_INSTALL_DIR>/eclipse/tools/imcl -consoleMode

Here,

<IM_INSTALL_DIR>
Indicates the directory where the IBM Installation Manager is installed.

2. Add the Sterling Business Intelligence installer repository location in the IBM
Installation Manager as follows:
a. Type P to select Preferences and press Enter.
b. Type 1 to select Repositories and press Enter.
c. Type D to select Add Repository and press Enter.
d. Enter the repository location to point to the repository.config file and

press Enter. A message will be displayed with the connection status of the
repository.

e. Type A to apply the changes and return to Preferences and press Enter.
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f. Type R to return to the main menu and press Enter.
3. Install the Sterling Business Intelligence application as follows:

a. Type 1 to install and press Enter.
b. Type the number associated with the IBM Sterling Business Intelligence

package and press Enter.
c. Type 1 to choose version 9.2.0 and press Enter.
d. Type N and press Enter.
e. Type M to change the location where Sterling Selling and Fulfillment

Foundation is installed, using the IBM Installation Manager.
f. Enter the location where Sterling Selling and Fulfillment Foundation is

installed and press Enter.
g. Type N and press Enter.
h. Type I to install and press Enter. A progress indicator shows the percentage

of installation completed.
i. After the installation is complete, the installation status is displayed.
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Chapter 5. Upgrading IBM Sterling Business Intelligence

Before you begin
1. Ensure that you have installed Sterling Selling and Fulfillment Foundation with

the Enable Upgrade option selected. For more information, refer to the Sterling
Selling and Fulfillment Foundation: Installation Guide .

Procedure
1. Install the Sterling Business Intelligence application. For installing Sterling

Business Intelligence application, refer to the topic Chapter 4, “Installing the
IBM Sterling Business Intelligence Application,” on page 9. For completing the
upgrade, refer to the upgrade instructions in the Sterling Business Intelligence:
Upgrade Guide.

2. To upgrade the Cognos Business Intelligence server and Cognos Adaptive
Analytics, refer to the upgrade instructions in the Sterling Business Intelligence:
Upgrade Guide.
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Chapter 6. Installing IBM Cognos Business Intelligence Server

The Cognos Business Intelligence server is installed on server 4.

For more information about the different installation options, refer to the following
link : http://publib.boulder.ibm.com/infocenter/cbi/v10r1m1/topic/
com.ibm.swg.ba.cognos.inst_cr_winux.10.1.1.doc/
c_distributionoptionsforcognosseries8.html#DistributionOptionsforCognosSeries8.

For more information about planning the installation, refer to the following link :
http://publib.boulder.ibm.com/infocenter/cbi/v10r1m1/topic/
com.ibm.swg.ba.cognos.inst_cr_winux.10.1.1.doc/
c_settinguptheenvironment.html#SettingUptheEnvironment.

Installing IBM Cognos Business Intelligence Server on One Computer
You can install all Cognos Business Intelligence components on one computer, or
distribute them across a network.

For more information on installing Cognos Business Intelligence server on one
computer, refer to the following link: http://publib.boulder.ibm.com/infocenter/
cbi/v10r1m1/topic/com.ibm.swg.ba.cognos.inst_cr_winux.10.1.1.doc/
c_installingandconfiguring8componentsononecomputer.html#InstallingandConfiguring8ComponentsonOneComputer.

Note: Perform the following steps after you install the Cognos Business
Intelligence server,
v Launch the Cognos Business Intelligence server user interface. In the

Configuration window, set the memory in MB to 1536.
v Modify the maximum memory configuration as follows:

– For Windows
In the <c_installation>\bin\startup.bat file, set CATALINA_OPTS=-Xmx1536m.

– For Unix
In the <c_installation>/bin/startup.sh file, set MEM=1536.

Installing IBM Cognos Business Intelligence Server on Different
Computers

You can install all Cognos Business Intelligence components on one computer, or
distribute them across a network.

For more information on installing Cognos Business Intelligence server on different
computers, refer to the following link: http://publib.boulder.ibm.com/infocenter/
cbi/v10r1m1/topic/com.ibm.swg.ba.cognos.inst_cr_winux.10.1.1.doc/
c_installingcognos8servercomponentsinadistributedenvironment.html#InstallingCognos8ServerComponentsinaDistributedEnvironment.

Note: Perform the following steps after you install the Cognos Business
Intelligence server,
v Launch the Cognos Business Intelligence server user interface. In the

Configuration window, set the memory in MB to 1536.
v Modify the maximum memory configuration as follows:
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– For Windows
In the <c_installation>\bin\startup.bat file, set CATALINA_OPTS=-Xmx1536m.

– For Unix
In the <c_installation>/bin/startup.sh file, set MEM=1536.
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Chapter 7. Installing the IBM Cognos Adaptive Warehouse

The Cognos Adaptive Warehouse component can be installed only on Microsoft
Windows.

The component is installed on server 5, as described in the topic Chapter 3,
“Understanding the IBM Sterling Business Intelligence Ecosystem,” on page 5.

For more information about the different installation options, refer to the following
link :http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
c_distributionoptionsforanalyticapps.html#DistributionOptionsforAnalyticApps.

For more information about planning your installation, refer to the following link :
http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
t_settinguptheenvironment_aapps.html

Installing the IBM Cognos Adaptive Warehouse on Windows
Before you begin

Ensure that you have performed the following tasks before you proceed with your
installation:
1. Ensure that you have installed and configured Cognos Business Intelligence

server. For more information about installing and configuring Cognos Business
Intelligence server, refer to Chapter 6, “Installing IBM Cognos Business
Intelligence Server,” on page 27

Procedure

For completing the installation and configuration of the Cognos Adaptive
Warehouse, refer to the following link http://publib.boulder.ibm.com/infocenter/
caapps/v10r1m0/topic/com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
c_installaaf.html#InstallAAF
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Chapter 8. Installing the IBM Cognos Adaptive Warehouse
Runtime

The Cognos Adaptive Warehouse Runtime is used to execute the extract,
transform, and load (ETL) scripts that have been generated from the Cognos
Adaptive Warehouse.

The Cognos Adaptive Warehouse Runtime is installed on server 6, as described in
the Chapter 3, “Understanding the IBM Sterling Business Intelligence Ecosystem,”
on page 5 topic.

For more information about the different installation options, refer to the following
link :http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
c_distributionoptionsforanalyticapps.html#DistributionOptionsforAnalyticApps.

For more information about planning your installation, refer to the following link :
http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
t_settinguptheenvironment_aapps.html

Installing the IBM Cognos Adaptive Warehouse Runtime on Windows
Before you begin

Ensure that you have performed the following tasks before you proceed with your
installation:
1. Ensure that you have installed and configured Cognos Business Intelligence

server. For more information about installing and configuring Cognos Business
Intelligence server, refer to Chapter 6, “Installing IBM Cognos Business
Intelligence Server,” on page 27.

Procedure

For completing the installation and configuration of the Cognos Adaptive
Warehouse Runtime, refer to the following link : http://publib.boulder.ibm.com/
infocenter/caapps/v10r1m0/topic/com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
t_apps_installingibmcognosadaptivewarehouseruntimeonwindows.html

Installing the IBM Cognos Adaptive Warehouse Runtime on Linux or
UNIX

Before you begin

Ensure that you have performed the following tasks before you proceed with your
installation:
1. Ensure that you have installed and configured Cognos Business Intelligence

server. For more information about installing and configuring Cognos Business
Intelligence server, refer to Chapter 6, “Installing IBM Cognos Business
Intelligence Server,” on page 27.
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Procedure

For more information about installation and configuring the Cognos Adaptive
Warehouse Runtime, refer to the following link: http://publib.boulder.ibm.com/
infocenter/caapps/v10r1m0/topic/com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
t_inst_aw_unix.html#inst_aw_UNIX.
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Chapter 9. Installing the IBM Cognos Adaptive Analytics

The Cognos Adaptive Analytics must be installed on the same server on which
Cognos Business Intelligence server is installed. The Cognos Adaptive Analytics is
installed on server 4, as described in the Chapter 3, “Understanding the IBM
Sterling Business Intelligence Ecosystem,” on page 5 topic.

For more information about the different installation options, refer to the following
link :http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
c_distributionoptionsforanalyticapps.html#DistributionOptionsforAnalyticApps.

For more information about planning your installation, refer to the following link :
http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
t_settinguptheenvironment_aapps.html

Installing IBM Cognos Adaptive Analytics on Windows
For more information on installing Cognos Adaptive Analytics on Windows, refer
to the following link: http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/
topic/com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/t_inst_aa_win.html#inst_aa_Win.

Installing IBM Cognos Adaptive Analytics on Unix or Linux
For more information on installing Cognos Adaptive Analytics on Unix or Linux,
refer to the following link: http://publib.boulder.ibm.com/infocenter/caapps/
v10r1m0/topic/com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
t_inst_aa_unix.html#inst_aa_UNIX.
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Chapter 10. Installing the IBM Sterling Business Intelligence
Content

IBM Sterling Business Intelligence Content can be installed on all platforms.

IBM Installation Manager installs IBM Sterling Business Intelligence Content in an
empty folder. You must ensure that the IBM Sterling Business Intelligence Content
is copied from this folder to the following locations:
v The server on which Cognos Business Intelligence server is installed. This folder

is referred to as <BI_COGNOS_HOME>.
v The server on which Cognos Adaptive Warehouse is installed. This folder is

referred to as <AC_INSTALL_DIR>.

Note: Ensure that there is at least 50 MB of free disk space available for
installation.

Installing IBM Sterling Business Intelligence Content using IBM
Installation Manager on Windows

Before you begin

Running the IBM Installation Manager in both GUI mode and command line mode
is not supported. Therefore, if the command line mode of the IBM Installation
Manager is open, ensure that you close it.

Ensure that you have performed the following tasks before you proceed with your
installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

About this task

You will find instructions to install content using the IBM Installation Manager
GUI on Windows.

Procedure
1. Execute the following command to start the IBM Installation Manager :

<IM_INSTALL_DIR>\eclipse\launcher.exe. The Start page of the Installation
Manager is displayed.

2. Add the repository location in the IBM Installation Manager as follows:
a. In IBM Installation Manager, click File > Preferences... > Repositories. The

Preferences page opens and displays the available repositories, repository
locations, and the connection status for the repositories.

b. Click Add Repository.

c. Enter the repository location or click Browse. When browsing, navigate to
the repository location and select the repository.config file.

d. Click OK. The new repository location is added to the list. If the repository
is not connected, a red box is displayed in the Connection column.
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e. Click OK to close the Preferences page.
3. Click Install in the IBM Installation Manager home page.
4. Select IBM Sterling Business Intelligence Content check box. Click Next.
5. Review and accept the license agreement. Click Next.
6. Click Create a new package group . Click Browse and navigate to the

directory in which you want to install the Content. The directory must be
empty. Click Next.

7. Click Next.
8. In the Summary page, the Packages are displayed. Click Install. A progress

indicator displays the percentage of the installation completed.
9. On successful completion, the Install Packages window is displayed with the

package details.
10. (Optional) Click View log file to open the installation log file for the current

session in a new window. You must close the Installation Log window to
continue.

Note: If the installation was not successful, click on the View log file to view
the failure reason.

11. Click Finish to complete the installation.

Installing IBM Sterling Business Intelligence Content using IBM
Installation Manager Command Line on Windows

Before you begin

You cannot run the IBM Installation Manager in both GUI and command line
mode. Hence, ensure that you have closed the GUI of the IBM Installation
Manager.

Ensure that you have performed the following tasks before you proceed with your
installation:
v Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

About this task

You can also install the IBM Sterling Business Intelligence Content using the IBM
Installation Manager command line (imcl) installation command. The imcl
command provides a text-based (non-GUI) interface.

Procedure
1. Execute the imcl command as follows:

v <IM_INSTALL_DIR>\eclipse\tools\imcl -consoleMode

Here,

<IM_INSTALL_DIR>
Indicates the directory where the IBM Installation Manager is installed.

2. Add the IBM Sterling Business Intelligence Content repository location in the
IBM Installation Manager as follows:
a. Type P to select Preferences and press Enter.
b. Type 1 to select Repositories and press Enter.
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c. Type D to select Add Repository and press Enter.
d. Enter the location of the repository location and press Enter.
e. Type A to apply the changes and return to Preferences and press Enter.
f. Type R to return to the main menu and press Enter.

3. Install the IBM Sterling Business Intelligence Content as follows:
a. Type 1 to install and press Enter.
b. Type the number associated with the IBM Sterling Business Intelligence

Content package and press Enter.
c. Type 1 to choose version 9.2.0 and press Enter.
d. Type N and press Enter.
e. Read each license agreement by typing the option number (1 or 2). After

reading, type R to return to the prompt. When ready to accept the license
agreements, type A and press Enter.

f. Type N and press Enter.
g. Type M to change the install location for IBM Sterling Business Intelligence

Content, using the IBM Installation Manager.
h. Enter the location of an empty folder where IBM Sterling Business

Intelligence Content will be installed, press Enter.
i. Type N and press Enter.
j. Type I to install and press Enter. A progress indicator shows the percentage

of installation completed.
k. After the installation is complete, the installation status is displayed.

Installing IBM Sterling Business Intelligence Content using IBM
Installation Manager on Unix or Linux

Before you begin

Running the IBM Installation Manager in both GUI mode and command line mode
is not supported. Therefore, if the command line mode of the IBM Installation
Manager is open, ensure that you close it.

Ensure that you have performed the following tasks before you proceed with your
installation:
1. Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.

2. Ensure that you set the display to your remote server using the following
command:
export DISPLAY=<server_ip_address>:0.0

For example, export DISPLAY=10.11.12.1:0.0

About this task

You will find instructions to install IBM Sterling Business Intelligence Content
using the IBM Installation Manager GUI on Unix or Linux.
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Procedure
1. Execute the following command to start the IBM Installation Manager :

<IM_INSTALL_DIR>\eclipse\launcher. The Start page of the Installation
Manager is displayed.

2. Add the repository location in the IBM Installation Manager as follows:
a. In IBM Installation Manager, click File > Preferences... > Repositories. The

Preferences page opens and displays the available repositories, repository
locations, and the connection status for the repositories.

b. Click Add Repository.

c. Enter the repository location or click Browse. When browsing, navigate to
the repository location and select the repository.config file.

d. Click OK. The new repository location is added to the list. If the repository
is not connected, a red box is displayed in the Connection column. Debug
your connectivity issues.

e. Click OK to close the Preferences page.
3. Click Install .
4. Select the IBM Sterling Business Intelligence Content. Click Next.
5. Review and accept the license agreement. Click Next.
6. Click Create a new package group . Click Browse and navigate to the

directory in which you want to install the IBM Sterling Business Intelligence
Content. The directory must be empty. Click Next.

7. Click Next.
8. In the Summary page, the Packages are displayed. Click Install. A progress

indicator displays the percentage of the installation completed.
9. On successful completion, the Install Packages window is displayed with the

package details.
10. (Optional) Click View log file to open the installation log file for the current

session in a new window. You must close the Installation Log window to
continue.

Note: If the installation was not successful, click on the View log file to view
the failure reason.

11. Click Finish to complete the installation.

Installing IBM Sterling Business Intelligence Content using IBM
Installation Manager Command Line on Unix or Linux

Before you begin

You cannot run the IBM Installation Manager in both GUI and command line
mode. Hence, ensure that you have closed the GUI of the IBM Installation
Manager.

Ensure that you have performed the following tasks before you proceed with your
installation:
v Install the IBM Installation Manager. For more information about installing the

IBM Installation Manager, refer to the Sterling Selling and Fulfillment Foundation:
Installation Guide.
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About this task

You can also install the IBM Sterling Business Intelligence Content using the IBM
Installation Manager command line (imcl) installation command. The imcl
command provides a text-based (non-GUI) interface.

Procedure
1. Execute the imcl command as follows:

v <IM_INSTALL_DIR>/eclipse/tools/imcl -consoleMode

Here,

<IM_INSTALL_DIR>
Indicates the directory where the IBM Installation Manager is installed.

2. Add the IBM Sterling Business Intelligence Content repository location in the
IBM Installation Manager as follows:
a. Type P to select Preferences and press Enter.
b. Type 1 to select Repositories and press Enter.
c. Type D to select Add Repository and press Enter.
d. Enter the location of the repository location and press Enter.
e. Type A to apply the changes and return to Preferences and press Enter.
f. Type R to return to the main menu and press Enter.

3. Install the IBM Sterling Business Intelligence Content as follows:
a. Type 1 to install and press Enter.
b. Type the number associated with the IBM Sterling Business Intelligence

Content package and press Enter.
c. Type 1 to choose version 9.2.0 and press Enter.
d. Type N and press Enter.
e. Read each license agreement by typing the option number (1 or 2). After

reading, type R to return to the prompt. When ready to accept the license
agreements, type A and press Enter.

f. Type N and press Enter.
g. Type M to change the install location for IBM Sterling Business Intelligence

Content, using the IBM Installation Manager.
h. Enter the location of an empty folder where IBM Sterling Business

Intelligence Content will be installed, press Enter.
i. Type N and press Enter.
j. Type I to install and press Enter. A progress indicator shows the percentage

of installation completed.
k. After the installation is complete, the installation status is displayed.
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Chapter 11. Deploy IBM Sterling Business Intelligence

About this task

To deploy Sterling Business Intelligence, perform the following steps:

Procedure
1. “Deploy the IBM Sterling Business Intelligence Application on Windows”
2. “Configure the IBM Cognos Business Intelligence Server” on page 43
3. “Setup for Accessing the IBM Cognos Business Intelligence Server from the

IBM Sterling Business Intelligence Application” on page 44
4. “Set Up Environment for IBM Cognos Analytic Applications” on page 45.
5. “Configure the IBM Cognos Adaptive Warehouse” on page 45
6. “Deploy Analytics Content” on page 45
7. “Deploy the Dashboard Reports to IBM Cognos Content Store” on page 49

Deploy the IBM Sterling Business Intelligence Application on Windows
About this task

Perform the following steps in the Sterling Transaction System (server 1) in which
the Sterling Business Intelligence Application is installed.

Procedure
1. To create an application EAR file, run the following command from the

<INSTALL_DIR>/bin directory:
v For Windows:

buildear.cmd -Dappserver=jboss -Dwarfiles=smcfs,sma,sbc,sbi
-Dearfile=smcfs.ear create-ear

Note:

v Here, the value of Dappserver depends upon the application server. For
JBoss, pass jboss in this parameter. For BEA WebLogic, pass weblogic and
for IBM WebSphere®, pass websphere

v You can add the following option to the buildear command if you do not
want to use Web services: Dnowebservice=true.

Running this command includes the sbi.war file into the smcfs.ear file.
2. You can build documentation EAR along with the application EAR. The doc ear

does not contain end-user documentation, such as the context-sensitive help
files. It contains only development-related documentation, including API
Javadocs, ERDs, and XSDs that should not be deployed to a production server.
It is recommended that you create documentation EAR only when you are
working in development environment.
To build the documentation EAR, smcfsdocs.ear along with the application
EAR, before running the buildear command, add the BUILD_DOC_EAR
property and set the value to "true" in the <INSTALL_DIR>/properties/
sandbox.cfg file and run the setupfiles script.
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Note: By default, the documentation EAR is not built and deployed with the
application EAR.

Note: The -Dnodocear parameter takes precedence over the BUILD_DOC_EAR
property. For example, if the BUILD_DOC_EAR property is set to "true" but the
-Dnodocear parameter is used with the create-ear script, the documentation
EAR does not build.
For more information about deploying the WAR and EAR files, refer to the
Sterling Selling and Fulfillment Foundation: Installation Guide.

Deploy the IBM Sterling Business Intelligence Application on Unix or
Linux

About this task

Perform the following steps in the Sterling Transaction System (server 1) in which
the Sterling Business Intelligence Application is installed.

Procedure
1. To create an application EAR file, run the following command from the

<INSTALL_DIR>/bin directory:
v For Linux or UNIX:

./buildear.sh -Dappserver=jboss -Dwarfiles=smcfs,sma,sbc,sbi
-Dearfile=smcfs.ear create-ear

Note:

v Here, the value of Dappserver depends upon the application server. For
JBoss, pass jboss in this parameter. For BEA WebLogic, pass weblogic and
for IBM WebSphere, pass websphere

v You can add the following option to the buildear command if you do not
want to use Web services: Dnowebservice=true.

Running this command includes the sbi.war file into the smcfs.ear file.
2. You can build documentation EAR along with the application EAR. The doc ear

does not contain end-user documentation, such as the context-sensitive help
files. It contains only development-related documentation, including API
Javadocs, ERDs, and XSDs that should not be deployed to a production server.
It is recommended that you create documentation EAR only when you are
working in development environment.
To build the documentation EAR, smcfsdocs.ear along with the application
EAR, before running the buildear command, add the BUILD_DOC_EAR
property and set the value to "true" in the <INSTALL_DIR>/properties/
sandbox.cfg file and run the setupfiles script.

Note: By default, the documentation EAR is not built and deployed with the
application EAR.

Note: The -Dnodocear parameter takes precedence over the BUILD_DOC_EAR
property. For example, if the BUILD_DOC_EAR property is set to "true" but the
-Dnodocear parameter is used with the create-ear script, the documentation
EAR does not build.
For more information about deploying the WAR and EAR files, refer to the
Sterling Selling and Fulfillment Foundation: Installation Guide.
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Configure the IBM Cognos Business Intelligence Server
You should apply Sterling Business Intelligence specific styles to the Cognos
Business Intelligence reports, and add the system.xml definition to enable the
relevant toolbar actions for the reports.

About this task

To apply Sterling Business Intelligence specific styles to reports, perform the
following tasks:

Note: It is recommended that you take a back up of the existing
reportstudio_en.xml and GlobalReportStyles.css files.

Procedure
1. The GlobalReportStyles.css file is found in multiple locations. You must copy

the contents of the <BI_COGNOS_HOME>\rs-export\Style_Sheet\
SBIReportStyles.css at the beginning of the GlobalReportStyles.css file in the
following locations:
v <c_installation>\<c_path>\reportstyles

v <c_installation>\<c_path>\bin

v <c_installation>\<c_path>\webcontent\reportstyles

v <c_installation>\<c_path>\webcontent\schemas

Note: If you do not copy the contents of the SBIReportStyles.css at the
beginning of the GlobalReportStyles.css file, then the reports and fonts will
not be displayed properly in Mozilla Firefox.

2. Edit the reportstudio_en.xml file under <c_installation>\<c_path>\msgsdk
and <c_installation>\<c_path>\webcontent\pat\res to add the content of
<BI_COGNOS_HOME>\rs-xport\Style_Sheet\SBI_reportstudio_en_sample.xml at
the end, just before the </section> tag. You must add only the content between
the comment tags <!-- SBI STARTS --> & <!-- SBI ENDS -->

3. Add the blue-top.png image file taken from <BI_COGNOS_HOME>\rs-export\
Style_Sheet, and copy the blue-top.png file into <c_installation>\<c_path>\
webcontent\samples\images. Ensure that the <c_installation>\<c_path>\
webcontent\samples\images directory has been created and the appropriate
permissions granted to users read from this directory.

4. Add the following lines to system.xml under <c_installation>\<c_path>\
templates\ps\portal\ and <c_installation>\<c_path>\templates\ps\. If you
have not defined the ui_hide parameter in system.xml, add the instructions
provided here. If you have already defined the ui_hide parameter, add only
those line items that are not defined.
<param name="ui_hide"><RV_HEADER/>
<RV_TOOLBAR_BUTTONS_DOWNLOAD/>
<RV_TOOLBAR_BUTTONS_SAVE/>
<RV_TOOLBAR_BUTTONS_SAVEAS/>
<RV_TOOLBAR_BUTTONS_SEND/>
<RV_TOOLBAR_BUTTONS_RUN/>
<RV_TOOLBAR_BUTTONS_XLS/>
<RV_TOOLBAR_BUTTONS_XLS_CSV/>
<RV_TOOLBAR_BUTTONS_XML/>
<RV_TOOLBAR_BUTTONS_XLS_SPREADSHEETML/>
<RV_TOOLBAR_BUTTONS_XLS_XLWA/>
<RV_TOOLBAR_BUTTONS_XLS_XLS/>
<RV_TOOLBAR_BUTTONS_XLS_SINGLEXLS/>
<RV_TOOLBAR_BUTTONS_DRILLDOWN/>
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<RV_TOOLBAR_BUTTONS_DRILLUP/>
<RV_TOOLBAR_BUTTONS_GOTO/>
<RV_TOOLBAR_BUTTONS_ADD_THIS_REPORT/>
<RV_TOOLBAR_BUTTONS_ADD_TO_MY_BOOKMARKS/>
<RV_TOOLBAR_BUTTONS_ADD_TO_MY_FOLDERS/>
<RV_TOOLBAR_BUTTONS_KEEP_THIS_VERSION/>
</param>

5. Perform the following steps to mask the As at Date box in Cognos Adaptive
Analytics:
a. Take a backup of the file <c_installation>\<c_path>\data\AA\templates\

ATTemplate_custom.xml.
b. Copy <BI_COGNOS_HOME>\rs-export\Style_Sheet\sbiaatemplate_custom.xml

file to <c_installation>\<c_path>\data\AA\templates\.
c. Rename <c_installation>\<c_path>\data\AA\templates\

sbiaatemplate_custom.xml to <c_installation>\<c_path>\data\AA\
templates\ATTemplate_custom.xml.

d. Copy the following text to the Settings section of Cognos Adaptive
Analytics configuration file <c_installation>\<c_path>\configuration\
aaConfig.xml : <EditATTemplate>on</EditATTemplate>.

e. Open Cognos Adaptive Analytics. Click the Project Actions icon, and select
Reload Analytic Type Template.

f. Deploy the Cognos Adaptive Analytics deployment archive. For more
information, refer to the topic “Deploy the IBM Cognos Adaptive Analytics
Content to IBM Cognos Content Store” on page 49.

6. Copy the <BI_COGNOS_HOME>\rs-export\Style_Sheet\SCLogo_Horiz_2C_WEB.png
image to the <c_installation>\<c_path>\webcontent\skins\business\
branding\ directory.

Setup for Accessing the IBM Cognos Business Intelligence Server
from the IBM Sterling Business Intelligence Application

About this task

To launch Cognos Business Intelligence Server from Sterling Business Intelligence,
you must configure the analytics.reportnet.url property in the
<INSTALL_DIR>/properties/customer_overrides.properties file.

The Cognos Business Intelligence Server URL format is:

http://<machinename>:<port_number>/ibmcognos/cgi-bin/cognos.cgi

<machinename>
Indicates the machine name or the IP address of the Cognos Business
Intelligence Server installation machine. Also, if you have changed the
reference URL for Cognos Business Intelligence using the IBM Cognos
Configurator, replace cognos with the correct path.

<port_number>
Indicates the port number.

For additional information about modifying properties and the
customer_overrides.properties file, refer to the Sterling Selling and Fulfillment
Foundation: Installation Guide and Sterling Selling and Fulfillment Foundation:
Properties Guide.

44 Sterling Business Intelligence: Installation Guide



You must also configure the analytics.namespace property in the
<INSTALL_DIR>/properties/customer_overrides.properties file. This property
indicates the namespace that is to be configured to authenticate users in Cognos
Business Intelligence.

Set Up Environment for IBM Cognos Analytic Applications
To set up the environment for the Cognos Analytic Applications, perform the
following steps:
1. Set up the Content Store (on server 7).
2. Set up database connectivity for the Content Store (from server 4).
3. Configure the Web server (involves setting up virtual directories on server 4).
4. Ensure that all the environment variables are set before launching the Cognos

Adaptive Warehouse Runtime and creating datasources.
5. Set up data sources (from Cognos Connection on server 4). Ensure that you

create the following data sources in the Cognos Business Intelligence server:
v Sterling Staging Data Source: This data source is mapped to the staging.
v Sterling Data Source: This data source is mapped to the Sterling Data Mart

Database.

Note: In a distributed installation, you must ensure that the Connect String
provided in the data source connection is the same in all the database clients.

For more information about setting up the environment for the Cognos Analytic
Applications, refer to the following link http://publib.boulder.ibm.com/
infocenter/caapps/v10r1m0/index.jsp?topic=
%2Fcom.ibm.swg.ba.cognos.inst_apps.10.1.0.doc
%2Fc_installationofibmcognosanalyticapplicationsapplicationcontent.html.

For more information about data source connections, refer to the Cognos Adaptive
Warehouse User Guide in the following link, http://publib.boulder.ibm.com/
infocenter/caapps/v10r1m0/topic/com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_aw_cnfg_sttgs_dw_db.html#aw_cnfg_sttgs_dw_db.

Configure the IBM Cognos Adaptive Warehouse
You must configure the Cognos Adaptive Warehouse to make it work in your IBM
Cognos environment.

Launch the Cognos Adaptive Warehouse configurator. Ensure that the
cryptographic settings are completed. If you have a distributed installation, it is
recommended that you set the value of the Store Symmetric Key field to False
locally. For more information about changing the cryptographic settings and
configuring the Cognos Adaptive Warehouse, refer to the following link
http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.inst_apps.10.1.0.doc/
t_inst_configureaafsingle.html#inst_ConfigureAAFsingle. This guide contains
separate instructions for single-computer installation and distributed installation.
Follow the appropriate configuration instructions.

Deploy Analytics Content
Deploying the Analytics Content includes the following steps:
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Procedure
1. “Set Up the IBM Cognos Adaptive Warehouse Content”
2. “Deploy the IBM Cognos Adaptive Warehouse Content to IBM Cognos Content

Store” on page 47
3. “Set Up the IBM Cognos Adaptive Analytics Content” on page 48
4. “Deploy the IBM Cognos Adaptive Analytics Content to IBM Cognos Content

Store” on page 49

Set Up the IBM Cognos Adaptive Warehouse Content
Setting up the Cognos Adaptive Warehouse content includes setting up content for
the warehouse schema.

About this task

To set up the Cognos Adaptive Warehouse content for the Data Mart warehouse
schema, perform the following steps:

Procedure
1. Launch the Cognos Adaptive Warehouse application from the Cognos

Adaptive Warehouse server (installed on server 5, as described in the topic
Chapter 3, “Understanding the IBM Sterling Business Intelligence Ecosystem,”
on page 5.

2. Create a new project in Cognos Adaptive Warehouse. To create a new project
in Cognos Adaptive Warehouse, you must first create a data source connection
that refers to the data mart. It is recommended that the data source connection
be named Sterling Data Source and it refers to the data mart. For more
information about creating a project in Cognos Adaptive Warehouse, refer to
the http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_wk_wth_prj_aw.html#wk_wth_prj_aw.

3. From the Actions menu of the Cognos Adaptive Warehouse application, select
Import from Content Library.

4. Click Browse, and select the library index file that you want to import from.
This file is available in the directory in which the Cognos Adaptive Warehouse
content is installed, and has a .pwi extension, for example,
<AC_INSTALL_DIR>/aw-export/sterling data source export/sterling data
source export.pwi

5. Click Open.
6. Click Next.
7. In the Conflict Resolution screen, select the conflict resolution that you want

to apply. By default, Full Upgrade is selected. For more details about conflict
resolution strategy, refer to the following link http://publib.boulder.ibm.com/
infocenter/caapps/v10r1m0/topic/com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
c_conflict_resolution.html#Conflict_Resolution.

8. Click Next

9. Click Next.
The details of the objects that you are importing are displayed.

10. Click Finish to run the import.
11. In the Data Source Mapping dialog box, select the IBM Cognos Content

Manager Data Sources corresponding to Sterling Staging Data Source.
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Note: The Sterling Staging data source should point to the Sterling Staging
Database schema, (installed on server 3, as described in the topic Chapter 3,
“Understanding the IBM Sterling Business Intelligence Ecosystem,” on page 5.

12. Click OK.
A pop-up window is displayed with warning messages. You can ignore the
warning messages pertaining to Common Code Union Source, SO Actual
Confirmed Union, Category Union, and Orphan Data.

13. Click OK.
The Validation Results screen is displayed.

14. Click Close.
15. Click OK.
16. From the Actions menu, select Synchronize Target Metadata.
17. From the File menu, select Save to save the project.

For more information about working with projects in Cognos Adaptive
Warehouse, refer to http://publib.boulder.ibm.com/infocenter/caapps/
v10r1m0/topic/com.ibm.swg.ba.cognos.ug_aw.10.1.0.doc/
t_managing_your_project.html#Managing_Your_Project.

Deploy the IBM Cognos Adaptive Warehouse Content to IBM
Cognos Content Store

About this task

Deploying the Cognos Adaptive Warehouse content includes deploying content for
the Data Mart warehouse schema.

To deploy the Cognos Adaptive Warehouse content for the Data Mart warehouse
schema to the Cognos Content Store, perform the following steps:

Procedure
1. Open the Sterling Data Source project.
2. Click the Target button to navigate to the target model.
3. Click Packages.

The following packages are displayed:
v Sterling Data Source

v Sterling Data Source Source

v IBM Adhoc Package

4. Select the Sterling Data Source package.
5. From the Actions menu, navigate to Package > Publish Packages.

The Publish Wizard-Select Location Type screen is displayed.
6. In the Publish Wizard-Select Location Type screen, make a choice about

whether to publish the package to Cognos Content Store or to a network
location.
v To enable model versioning when publishing to the Cognos Content Store,

select the Enable model versioning checkbox and enter the number of
model versions pertaining to the packages that are to be retained.

Note: To delete all but the most recently published version of the model on
the server, select the Delete all previous model versions check box.

v To validate your warehouse model prior to publishing, clear the Verify the
package before publishing check box.
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Note: It is recommended that you retain the default selection in order to
ensure that the package is complete, and does not contain any errors.

7. Click Next.
The Add Security screen is displayed.

8. Click Next.
The Publish Wizard-Options screen is displayed.

9. Click Publish.
10. Click Finish.

A warning message is displayed in the Verify Model screen, indicating that
the package contains orphan dimensions. You can ignore the message.
To publish the Sterling Data Source Source package, select the Sterling
Data Source Source package and repeat steps 5 to 9.
To publish the IBM Adhoc Package package, select the IBM Adhoc Package
package and repeat steps 5 to 9.

11. Click Close.

Set Up the IBM Cognos Adaptive Analytics Content
Before you begin

Ensure that Calendar dataflow is loaded before importing content to Cognos
Adaptive Analytics.

About this task

You must import business content from a content library into a project to take
advantage of the content included in Cognos Adaptive Analytics. The content
library contains information packages, metric types, hierarchies, operational report
specifications, and global data pertaining to the Cognos Adaptive Analytics
application.

To set up the Cognos Adaptive Analytics content, perform the following steps:

Procedure
1. Launch the Cognos Adaptive Analytics application.
2. Create a new project by selecting a data source connection that references the

data mart Cognos Adaptive Warehouse model. It is recommended that you
specify the project name as Sterling Analytics. Specify the Data source as
Sterling Data Source and the Schema. Specify the Package name as Sterling
Data Source. For more information about creating a new project, refer to the
following link http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/
topic/com.ibm.swg.ba.cognos.ug_aa.10.1.0.doc/t_creating_project.html.

3. In the Create content tab, click on the Project Actions icon, select Import from
Content Library.

4. In the Objects to import screen, click on Library Content file to open the
Content Library files window screen.
a. In the Content Library files window, select Sterling AA Export.xml file.
b. Click OK.
c. In the Objects to import screen, select Information Packages.
d. Click Next.

e. Select Full Upgrade.
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f. Click Finish.

Deploy the IBM Cognos Adaptive Analytics Content to IBM
Cognos Content Store

To deploy the Cognos Adaptive Analytics content to Content Store, you must
create a deployment archive in Cognos Adaptive Analytics. To create a deployment
archive, perform these steps:

Procedure
1. From the Project Actions menu in the Cognos Adaptive Analytics application,

select Create Deployment Archive.
2. In the Create a deployment archive box, enter a name for the archive.
3. Click OK.

Results

The deployment archive is created, and you can now publish your reports in IBM
Cognos Connection.

For more information about publishing your reports in Cognos Connection, refer to
the following link :http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/
topic/com.ibm.swg.im.cognos.ug_cra.10.1.0.doc/
ug_cra_id21985DeployingData.html#DeployingData.

Note: You cannot view data in the reports until the data is loaded into the data
mart. For more information about loading data into the data mart and setting up
load management, refer to the Sterling Business Intelligence: Implementation Guide.

Deploy the Dashboard Reports to IBM Cognos Content Store
About this task

Note: Dashboards.zip should be imported to content store only after importing
Adaptive Analytics Deployment Archive.

To deploy the dashboards to Cognos Content Store, perform the following steps:

Procedure
1. Copy the <BI_COGNOS_HOME>/Dashboards.zip file to the <c_installation>/

<c_path>/deployment folder.
2. Launch Cognos Connection
3. Import the Dashboards.zip file to Cognos Content Store.

For more information about importing the deployment archive to Cognos
Content Store, refer to the following link http://publib.boulder.ibm.com/
infocenter/caapps/v10r1m0/topic/com.ibm.swg.im.cognos.ug_cra.10.1.0.doc/
ug_cra_id21189Deployment.html#Deployment.
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Chapter 12. Security Administration

Set Up the IBM Sterling Business Intelligence Authentication
Mechanism

Before you begin

Prior to setting up the Sterling Business Intelligence Authentication Mechanism,
perform the following tasks:
1. Copy the <BI_COGNOS_HOME>/lib/sscap-auth.jar file to the

<c_installation>/<c_path>/webapps/p2pd/WEB-INF/lib folder into the machine
in which Cognos Business Intelligence server has been installed.

2. Copy the <BI_COGNOS_HOME>/analytics.properties.sample file to the
<c_installation>/<c_path>/webapps/p2pd/WEB-INF/classes folder.

3. Save the <c_installation>/<c_path>/webapps/p2pd/WEB-INF/classes/
analytics.properties.sample file as analytics.properties in the same folder.

4. Change the value of the sscap.app.url property to point to the Sterling Selling
and Fulfillment Foundation URL:
If Sterling Selling and Fulfillment Foundation is configured for HTTP, then
sscap.app.url=http://hostname:port/smcfs

If Sterling Selling and Fulfillment Foundation is configured for HTTPS, then
sscap.app.url=https://hostname:port/smcfs

Note: The sscap-auth.jar contains the YantraAuthenticationServlet which
authenticates the user credentials being passed from Cognos Business Intelligence.
The servlet resides on the Sterling Business Intelligence server and does the
following:
v Authenticates the user
v Provides information about user details/user groups
v Verifies that the user is a Cognos Business Intelligence Administrator and

returns user groups based on the user resource permissions

About this task

To set up the Sterling Business Intelligence Authentication Mechanism, perform the
following tasks:

Procedure
1. Launch IBM Cognos Configuration.
2. Click Security > Authentication> Cognos.
3. Click the Value box for Allow anonymous Access , select False.
4. Right-click Authentication, and click New Resource > Namespace.
5. In the Name box, type smcfs.
6. In the Type list, click Custom Java™ Provider

7. In the Resource Properties panel, enter
com.yantra.authenticator.YantraAuthentication as the Java class name.

8. From the File menu, click Save.
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Setting Up Access to IBM Cognos Administration and Reporting
To help increase the security of your business systems and data with Sterling
Business Intelligence, you can be selective in assigning access to the IBM Cognos
administrative functions, reports, folders, and packages. Use the Sterling Business
Intelligence Administrator platform resource to assign these permissions.

To set up access to IBM Cognos Administration and Reporting, perform the
following tasks:
v Control access to IBM Cognos Administration
v Control access to IBM Cognos Reports, Folders, and Packages

Control Access to IBM Cognos Business Intelligence
Administration

About this task

The first task in configuring user access to Cognos Business Intelligence
administration is to grant permissions to the Sterling Business Intelligence
Administrator resource in the Sterling Application Platform. You must have
security groups created in the Sterling Selling and Fulfillment Foundation prior to
completing this task. The Sterling Business Intelligence Administrator will
automatically be granted Cognos Business Intelligence administrative capabilities.

Procedure
1. In the Sterling Selling and Fulfillment Foundation Applications Manager, select

Application > Application Platform.
2. From the tree in the application rules side panel, select Security > Groups.

The Groups screen is displayed in the work area.
3. Double click on the group to be given permissions to access the Cognos

Business Intelligence screens. The Group Details screen opens.
4. In the Group Details screen, Permissions tab, Click on Permissions button for

Sterling Business Intelligence. The Permissions screen opens.
5. In the Permissions screen, navigate to the entity you want to give permissions.

For example, to give permissions to Profit Margin Report, select Applications >
Sterling Business Intelligence> Entities >SBIReports>Profit Margin Report.

6. Right click and select Check All.
7. Click Save.

Editing the System Administrator Role in IBM Cognos
Business Intelligence

The second task in limiting access to administration functionality is to make two
changes to the System Administrator role in Cognos Business Intelligence. The two
changes are described in “Adding the smcfs/SYSTEM Group” on page 53 and
“Removing the Everyone Group from the System Administrator Role” on page 53.
You can only complete this task after you set access to Cognos Business
Intelligence administration. See “Adding the smcfs/SYSTEM Group” on page 53.

When a user launches Cognos Connection through the Console, all user groups to
which that user belongs are displayed. If the user has permission to access the
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Sterling Business Intelligence Administrator, the user sees all groups defined in the
database and an additional group called smcfs/SYSTEM. Otherwise, the user sees
only the groups to which he belongs.

In Cognos Business Intelligence, by default, all users have administrative
capabilities because the Everyone group (which includes all users) is included in
the System Administrator role.

Adding the smcfs/SYSTEM Group
About this task

Note: You must complete this task before deleting the Everyone group (see
“Removing the Everyone Group from the System Administrator Role”).

When you grant BI Admin rights to a user in the Sterling Selling and Fulfillment
Foundation Applications Manager, a new group called SYSTEM is displayed in the
user's list of groups under the smcfs namespace in Cognos Business Intelligence.
Add this smcfs/SYSTEM group to the System Administrator role in Cognos
Business Intelligence:

Procedure
1. Start your Web browser and enter the URL of your Cognos Business

Intelligence applications (the default is http://localhost/ibmcognos).
The Cognos Business Intelligence home page displays.

2. Click Cognos Connection.
3. Log in to the Cognos Connection portal as a System Administrator.
4. Locate smcfs in the list of roles, and click smcfs.
5. Locate SYSTEM in the list, and click the Set Properties icon in the Action

column.
6. The Set Properties - SYSTEM screen displays. Select the Permissions tab.
7. Check the Override the access permissions acquired from the parent entry

checkbox.
8. Click Add. The Select Entries - System screen displays.
9. Click smcfs.

10. In Available Entries, select the System checkbox and click the arrow to move
it to Selected Entries. Click OK. The Set Properties - System screen displays.

Removing the Everyone Group from the System Administrator
Role
About this task

After adding the smcfs/SYSTEM group to the System Adminstrator role, remove
the Everyone group from the System Administrator role:

Procedure
1. Log in to the IBM Cognos Connection portal as a System Administrator.
2. Go to Tools > Directory and select the IBM Cognos Business Intelligence

namespace.
3. Locate System Administrators in the list of roles, and click the Set Properties

icon in the Action column.
4. Select the Members tab. Select Everyone, and click Remove.
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Results

The result is that only users who have permission to access the Sterling Business
Intelligence Administrator have administrative capabilities in IBM Cognos Business
Intelligence.

Controlling Access to IBM Cognos Business Intelligence
Reports, Folders, and Packages

About this task

The second part of controlling Cognos Business Intelligence access through Sterling
Business Intelligence is to set specific permissions to entries in Cognos Business
Intelligence.

Procedure
1. In Cognos Connection on the Capability screen, locate the entry for which

you want to set access permissions.
2. Click the down-arrow icon next to the desired entry to display the

corresponding Set Properties menu. Click Set Properties. The Set Properties
screen displays.

3. In the Set Properties screen, select the Permissions tab.
4. Choose whether to use the permissions of the parent entry or select

permissions specifically for the entry:
v To use the permissions of the parent entry, clear the Override the access

permissions acquired from the parent entry option. If you are prompted to
use the parent permissions, click OK in the prompt dialog. Click OK on the
Set Properties screen.

v To set access permissions for the entry, select the Override the access
permissions acquired from the parent entry option. Proceed to step 5.

5. To remove an entry from the list, select it and click Remove.
6. To specify a new entry for which you want to grant or deny access, click Add.
7. The Select Entries screen displays. Click smcfs.
8. In Available Entries, select the SYSTEM checkbox and click the arrow to move

it to Selected Entries.
9. Select entries using one of the following methods:

v To choose from the listed entries, click the appropriate namespace, and
select the users, groups, or roles.

v To enter new names, click Type and type the names of the groups, roles, or
users into the Entries field. Separate multiple entries with a semicolon (;).
For example: smcfs/SYSTEM;Cognos/Everyone

10. Click the right-arrow to move entries to the Selected entries box and click OK
when done. You return to the Permissions tab on the previous screen (Set
Properties).

11. Click add. You return to the Select entries screen.
12. Select smcfs and then click the arrow to move smcfs to Selected Entries. Click

OK. You return to the Permissions tab, with smcfs added to the Name
column.

13. To specify permissions for a user, group, or role, select the appropriate
checkbox in the Name column and then select permissions checkboxes in the
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Grant or Deny columns. The icon next to each user, group, or role in the
Permissions column represents the type of access granted or denied. Repeat
this step for each user, group, and role.

14. If you want to replace the existing permissions of the child entries with the
permissions you set for this entry, in the Option section, select the Delete the
access permissions of all child entries check box. This option appears only
with the entries that are containers.

15. Click OK.

Note: The above steps should be followed for changing Permissions at the
Reports Level and for other IBM Cognos Components and Packages.
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Chapter 13. Verify the IBM Sterling Business Intelligence
Installation

To verify the Sterling Business Intelligence installation, you must launch the
Sterling Business Intelligence application, launch the reports, and perform load
management.

About this task

Note: It is assumed that all the services and servers have been restarted after the
execution of configuration-related tasks.

To launch Sterling Business Intelligence, perform these steps:

Procedure
1. Open a browser and type the corresponding URL in the address bar, for

example, http://<hostname>:<port>/sbi/bi/launch.jsp
2. Click Go.

The Sterling Business Intelligence Login page is displayed.
3. Enter a valid Login ID and Password.
4. Click Sign In.

The Sterling Business Intelligence application home page is displayed.

Note: The Sterling Business Intelligence application screens have been designed
for 1024x768 resolution. For better viewing experience, change the display
resolution accordingly.
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Chapter 14. Verify the IBM Sterling Business Intelligence
Report

About this task

Verify if the installation was successful by launching the Sterling Business
Intelligence report.

Procedure
1. Launch the Sterling Business Intelligence application.

The Sterling Business Intelligence application home page is displayed.
2. From the Order menu, select the report you want to view.

The corresponding report is displayed.

Results

After the verification is completed, you must load data into the data mart. Prior to
starting the load management activities, ensure that all servers are time
synchronized using services like Network Time Protocol (NTP) to a single clock
source. In case the Platform considerations do not allow for time synchronization,
the IBM Cognos server should run one minute slower than the OLTP server. For
more information about load management, refer to the Sterling Business Intelligence:
Implementation Guide.
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Chapter 15. Installing IBM Sterling Business Intelligence
Language Pack

Before installing the Sterling Business Intelligence language pack, ensure that you
have successfully installed Sterling Selling and Fulfillment Foundation, Release 9.2.

Language packs are compressed files that are compatible with the UNIX, Linux,
and Windows operating systems. Ensure that you install the Sterling Selling and
Fulfillment Foundation language pack, before you install the Sterling Business
Intelligence language pack. For more information about installing the Sterling
Selling and Fulfillment Foundation language pack, refer to the Sterling Selling and
Fulfillment Foundation: Installation Guide.

Install the Language Pack for IBM Sterling Business Intelligence
Dashboard Literals

About this task

To install and localize the language pack for dashboard literals, perform the
following tasks:

Procedure
1. Extract the SBI-Analytics9.2_<language>_<locale>.zip file from the language

pack CD to the <BI_COGNOS_HOME> directory. Ensure that the
sbianalyticsbundle_<language>_<locale>.properties file exists in
<BI_COGNOS_HOME>/resources/ directory.

2. Ensure that the environment variables BI_RT and BI_COGNOS_HOME are correctly
set, For example in UNIX,
export BI_RT = <BI_COGNOS_HOME>

export BI_COGNOS_HOME = <BI_COGNOS_HOME>

The <BI_COGNOS_HOME> directory is the root directory where the Sterling
Business Intelligence content for Cognos Business Intelligence is installed.

3. Copy the following jar files to <BI_COGNOS_HOME>/lib folder from
<COGNOS_HOME>/<c_path>/webapps/p2pd/WEB-INF/lib folder.
v activation.jar
v axis.jar
v axisCrnpClient.jar
v CAM_AAA.jar
v CAM_AAA_CustomIF.jar
v commons-discovery-0.2.jar
v commons-logging-1.1.jar
v dom4j-1.6.1.jar
v jaxrpc.jar
v saaj.jar
v soap.jar
v sscap-auth.jar
v wsdl4j-1.5.1.jar
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v xalan.jar
v xercesImpl.jar
v xml-apis.jar

4. Ensure that you have disabled the Cognos Business Intelligence authentication.
5. To localize the dashboard literals in the <BI_COGNOS_HOME> folder, copy execute

the following command from the <BI_COGNOS_HOME>/bin folder: ant -f
sbilocalizer.xml import

Note:

v If you have installed Sterling Business Intelligence Content for Cognos
Business Intelligence and Sterling Business Intelligence on two different
machines, you must modify the following line of the XML by replacing
localhost with the IP address of the machine on which Sterling Business
Intelligence content for Cognos Business Intelligence has been installed
before you execute the command:
<property name="cognosurl" value="http://localhost:<port>/p2pd/
servlet/dispatch"/>

The sbilocalizer.xml command reads all the bundles in the
<BI_COGNOS_HOME>/resources folder. It then adds the literal translations for each
locale into the dashboard definitions present in the <BI_COGNOS_HOME>/reports
folder. The modified dashboard definitions are copied into the
<BI_COGNOS_HOME>/localizedreports folder, and added into the content
repository. When the dashboards are generated again, the literals are displayed
according to the user's locale.

6. Ensure that you enable the Cognos Business Intelligence authentication.

Install Language Pack for IBM Cognos Adaptive Warehouse
About this task

To install the language pack to localize the Cognos Adaptive Warehouse, perform
the following tasks:

Procedure
1. Extract the SBI-Analytics9.2_<language>_<locale>.zip file from the language

pack CD to the <AC_INSTALL_DIR> directory.
2. Launch the Cognos Adaptive Warehouse application and click on the Target

tab to open the Target view.
3. From Project menu, navigate to Languages > Define Languages. The Define

Languages window is displayed.
4. From the Available Languages list, select each language that you want to add

and click the arrow button to move it to the Project languages box and click
OK.

5. From the Project menu, navigate to Languages > Import Translation File. The
Import Translation File window is displayed.

6. From the Project Languages list, select the required project language and add
it into Translate into box.

7. Select the <AC_INSTALL_DIR>\resources\
sbiawbundle_<languagecode>_<localecode>.txt file that must be imported.
Sterling Business Intelligence Analytics Content is installed in
the<AC_INSTALL_DIR> folder.

8. Click OK.
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9. Click Save.
10. In the Target tab, in the Project Viewer pane, click on Packages > Sterling

Data Source.
11. In Properties window click on Language, Languages window is displayed.
12. In the Languages window, select the language that you want to add from the

Available Languages list and click the arrow button to move it to the Project
languages box. Click OK.

13. Click Save.
14. Publish the Sterling Data Source Package.
15. In the Target tab, in the Project Viewer pane, click on Packages > IBM Adhoc

Package. Repeat steps 11 - 13.
16. Publish the IBM Adhoc Package.

Install Language Pack for IBM Cognos Adaptive Analytics
Before you begin

Before installing the applications language pack, ensure that you have installed the
Sterling Selling and Fulfillment Foundation language pack. For more information
about installing the Sterling Selling and Fulfillment Foundation language pack,
refer to the Sterling Selling and Fulfillment Foundation: Installation Guide.

About this task

To install the language pack to localize the Cognos Adaptive Analytics, perform
the following tasks:

Procedure
1. Extract the SBI-Analytics9.2_<language>_<locale>.zip file from the language

pack CD to the <AC_INSTALL_DIR> directory.
2. Copy <AC_INSTALL_DIR>/resources/

sbiaabundle_<languagecode>_<localecode>.txt to <c_installation>/
<c_path>/data/aa/content/.

3. Launch the Cognos Adaptive Analytics and open the project that you want to
localize.

4. From Project Actions icon, navigate to Select Languages > Define Languages.
The Select Languages window is displayed.

5. From the Available Languages list, select each language that you want to add
and click the arrow button to move it to the Selected Languages box and click
OK.

6. From the Project Actions icon, select Import Translation File. The Import
translation file window is displayed. Select the
sbiaabundle_<languagecode>_<localecode>.txt file.

7. Click OK. The import completed successfully message appears. Click OK.
8. From the Project Actions icon, select Create a Deployment Archive. The

Create a deployment archive window is displayed.
9. In the New archive box, enter a name for the new archive.

10. Click OK. The deployment archive was created message is displayed. Click
OK.

11. The deployment archive is created. You can now publish your reports in
Cognos Connection. Deploy the deployment archive to publish the reports.
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For information on deploying the deployment archive, refer to
http://publib.boulder.ibm.com/infocenter/caapps/v10r1m0/topic/
com.ibm.swg.im.cognos.ug_cra.10.1.0.doc/
ug_cra_id21189Deployment.html#Deployment.

Install the Language Pack for IBM Sterling Business Intelligence
About this task

To install the Sterling Business Intelligence language pack, perform the following
steps.

Procedure
1. Extract the SBI9.2_<language>_<locale>.zip file from the language pack CD to

the <INSTALL_DIR> directory.
2. Ensure that you re-create the resource JAR file and the EAR file.

Localize IBM Sterling Business Intelligence Reports and Dashboard
Data

You can localize the data in the Sterling Business Intelligence reports and
dashboards using the Cognos Adaptive Warehouse application. All the data
present in a dashboard that describing an entity, for example, Category
Description, Region Description, Buyer Description and so on, are localized in the
data warehouse database. The data warehouse database contains localized data
from the YFS_LOCALIZED_STRINGS table, which is transformed and added as
additional columns.

Before you begin

Note: Before you start the data localization process, the database factory default
values must be localized. For more information about localization for multilingual
installation, refer to the Sterling Selling and Fulfillment Foundation: Localization Guide.

About this task

To localize the data in the Sterling Business Intelligence reports and dashboards,
perform the following tasks:

Procedure
1. Launch the Cognos Adaptive Warehouse application. By default, the

application opens in the Warehouse view.
2. From the Actions menu, select Edit Data languages.

The Specify Project Languages pop-up window is displayed.
3. Click Add.
4. Enter the New Languages and Language code.
5. Click OK.
6. Click Synchronize Target Metadata.
7. Click Save and perform the load management.

For more information about performing load management, refer to the IBM
Cognos Analytic Applications Adaptive Warehouse User Guide.
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Localizing the Factory Setup Data
Besides storing your transactional data, the database also stores configuration data,
such as error codes. This means that the database may need to store values in a
language-specific format. If these database literals are not localized, screen literals
are displayed inconsistently, with some being displayed in the localized language
and others being displayed in English.

To localize the factory setup data, perform the following tasks:
1. Extract the SBI9.2_<language>_<locale>.zip file from the language pack CD to

the <INSTALL_DIR> directory. <INSTALL_DIR> is the directory where the Sterling
Selling and Fulfillment Foundation is installed. Ensure that the file
en_US_sbifcliterals2translate_<language>_<locale>.properties is present in
the <INSTALL_DIR>/installed_data/smcfs/components/complete_installation/
factorysetup/XMLS directory.

2. Execute the following command from the <INSTALL_DIR>/bin folder:
For Windows: sci_ant.cmd -f localizedstringreconciler.xml import
-Dsrc=<INSTALL_DIR>\installed_data\smcfs\components\
complete_installation\factorysetup\XMLS
-Dbasefilename=sbifcliterals2translate

For UNIX or Linux: sci_ant.sh -f localizedstringreconciler.xml import
-Dsrc=<INSTALL_DIR>/installed_data/smcfs/components/
complete_installation/factorysetup/XMLS
-Dbasefilename=sbifcliterals2translate
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be

© Copyright IBM Corp. 2009, 2011 67



incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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